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LESSON SKILL MATRIX

Skills Exam Objective Objective Number

Working in the PowerPoint Window

Working with an Existing Presentation Demonstrate how to use views to navigate 

through presentations.

1.3.3 

Change to view in color/grayscale. 1.3.2

View multiple presentations. 5.1.3

•  placeholder 

•  Quick Access Toolbar 

•  Reading view 

•  Ribbon 

•  ScreenTip 

•  shortcut menu 

•  Slide Show view 

•  Slide Sorter view 

•  tab 

•  text box 

•  views 

•  zoom 

   KEY TERMS 

•  Backstage view 

•  command 

•  dialog box 

•  dialog box launcher 

•  drop-down arrow 

•  drop-down list 

•  File tab 

•  group 

•  I-beam pointer 

•  KeyTip 

•  Mini toolbar 

•  Normal view 

•  Notes Page view 
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Lesson 12

 Blue Yonder Airlines is a small but rapidly growing company that offers 

charter fl ights to adventurous or exotic locations. The service is de-

signed for small groups, such as corporate management teams or direc-

tors who want to mix business and pleasure in a packaged getaway. As 

an enterprise account manager, your job is to introduce Blue Yonder 

 Airlines to executives in mid-sized and large companies. Your goal is to 

convince these managers to use your charter service when arranging 

off-site gatherings that require group travel. Microsoft PowerPoint 2013 

provides the perfect set of tools for presenting this information to your 

potential customers. In this lesson, you will start PowerPoint and open 

an introductory presentation about Blue Yonder Airlines. You will learn to navigate, edit, save, print, and 

close a presentation. 

 SOFTWARE ORIENTATION 

 Normal View 

 Before you begin working in Microsoft PowerPoint 2013, you should be familiar with the 
primary user interface. When you fi rst start PowerPoint, you will see a Start screen. If you 
then press Esc, you see a screen similar to the one shown in Figure 1-1, which is Normal view, 
where you will do most of your work. However, if your copy of PowerPoint has been custom-
ized, what you see may be slightly different from what is shown. You can use this fi gure as a 
reference throughout this lesson and the rest of this book. 

Figure 1-1

The PowerPoint window in Normal view

Quick Access Toolbar Slides pane

Ribbon

Slide pane

(main work area)

Title placeholder

Status bar

Subtitle

placeholder
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 The Ribbon across the top of the window contains a set of tabs; each tab has a different collection 
of groups and buttons on it. Additional contextual tabs appear when you select certain types of 
content, such as graphics or tables.  

 WORKING IN THE POWERPOINT WINDOW 

 To use PowerPoint 2013 effi ciently, you need to learn how to navigate in the PowerPoint applica-
tion window. 

 Starting PowerPoint 

 Before you can use PowerPoint, you need to start the program. In this exercise, you learn to start 
PowerPoint using the Start screen or Start button. The steps for starting PowerPoint depend on 
which version of Windows you have on your PC. PowerPoint 2013 runs on either Windows 7 or 
Windows 8. 

STEP BY STEP  Start PowerPoint (Windows 8) 

  GET READY . Before you begin these steps, make sure that your computer is on. Sign on, if 

necessary. 

1.    If the Start screen does not already appear, press the  Windows key  on the keyboard to 

display it. 

2.      If needed, scroll to the right to locate the PowerPoint 2013 tile (see Figure 1-2). 

The Bottom Line

3.      Click  PowerPoint 2013 . PowerPoint starts and its Start screen appears. 

4.    Press  Esc  or click  Blank Presentation . A new, blank presentation appears in the 

PowerPoint window. 

    PAUSE .  LEAVE  the blank presentation open to use in the next exercise. 

Another Way
 Instead of locating 

the PowerPoint 2013 tile by 
scrolling, you can type the fi rst 
few letters to fi lter the 
displayed tiles to show only the 
one you want.  

Another Way
 From the Start 

screen, you can right-click the 
PowerPoint 2013 tile and 
choose Pin to taskbar. This 
places a shortcut to PowerPoint 
on the desktop’s taskbar, and 
you can click that shortcut to 
start PowerPoint. 

Figure 1-2

Starting PowerPoint

PowerPoint 2013 tile
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Lesson 14

STEP BY STEP Start PowerPoint (Windows 7) 

GET READY . Before you begin these steps, make sure that your computer is on. Log on, if 

necessary. 

1.    On the Windows taskbar at the bottom of your screen, click the  Start  button, and then 

click  All Programs . A menu of installed programs appears. 

2.    Click  Microsoft Offi ce . A submenu opens, listing the available programs in your 

installation of Microsoft Offi ce. 

3.    Click  Microsoft PowerPoint   2013.  PowerPoint starts and its Start screen appears. 

4.    Press  Esc    or click  Blank Presentation . A new, blank presentation appears in the 

PowerPoint window. 

  PAUSE .  LEAVE  the blank presentation open to use in the next exercise. 

SELECTING TOOLS AND COMMANDS 

 A  command  is a tool (such as an icon, a button, or a list) that tells PowerPoint to perform a spe-
cifi c task. Each tab provides commands that are relevant to the kind of task you are performing—
whether you are formatting a slide, adding animations to a presentation, or setting up a slide show 
for display. Most of the tools and commands for working with PowerPoint are accessible through 
the PowerPoint Ribbon. In addition to the Ribbon, PowerPoint also offers tools and commands 
on the File menu (also known as  Backstage   v  iew ), a Quick Access toolbar, a fl oating mini-toolbar, 
and a status bar. 

 Using the Ribbon 

 In this exercise, you learn how to select commands from the  Ribbon , which is the tabbed toolbar 
at the top of the window. The Ribbon is divided into  tabs , and each tab contains several  groups  
of related commands. 

 On the Ribbon, some command groups feature a tool called a  dialog box launcher —a small 
 arrow in the group’s lower-right corner. You can click the arrow to open a  dialog box , which pro-
vides tools and options related to a specifi c task. To close a dialog box without accepting any 
changes you may have made to it, click the Cancel button. 

 Some of the Ribbon’s tools have small, downward-pointing arrows next to them. These arrows are 
called  drop-down arrows ; when you click one, a  drop-down list  opens, displaying options you 
can choose (such as a list of fonts). You can choose the option you want by clicking it. 

 If you need more space on your screen, you can minimize (hide) the Ribbon by double-clicking 
the active tab. To restore the Ribbon, double-click the active tab again. 

STEP BY STEP Use the Ribbon 

USE the new, blank presentation that is still open from the previous exercise. 

1.      Look at the Ribbon, which appears in Figure 1-3. Note that each tab contains several 

groups of related commands. By default, the  Home  tab is active. 

Another Way
 You can also click 

the Start button and then begin 
typing PowerPoint; after you 
have typed the fi rst few letters, 
PowerPoint should appear 
above the Start button; click on 
it there to start the program. 

Another Way
If PowerPoint has 

recently been used on your 
computer, it may appear on the 
top level of the Start menu, 
when you fi rst click the Start 
button. If it appears there, you 
can click that shortcut to start 
the program, rather than 
clicking All Programs and 
Microsoft Offi ce to fi nd it. 
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2.  Click the  Design  tab to make it active. The groups of commands change. 

3.  Click the  Home  tab. 

4.  On the slide, click anywhere in the text  Click to add title . The text disappears and a 

blinking insertion point appears. 

 You will learn about adding and editing text later in this lesson. 

5.    In the lower-right corner of the Font group, click the  dialog box launcher  (the small box 

with a diagonal, downward-pointing arrow, see Figure 1-3). Clicking this button opens 

the Font dialog box. Click  Cancel  to close the dialog box. 

6.      In the Font group, click the  Font   list   drop-down arrow . A drop-down list appears (see 

Figure 1-4). This list shows all the fonts that are currently available for use. The default 

font for headings is Calibri Light.  

Cross 
Ref

Another Way
 You can also open 

the Font dialog box by 
pressing Ctrl 1 Shift 1 F. Many 
common commands have 
keyboard shortcuts; the 
PowerPoint Help system 
(covered later in this lesson) 
can help you identify them. 

Another Way
You can also 

collapse the Ribbon by 
right-clicking one of its tabs 
and clicking Collapse the 
Ribbon. Repeat that procedure 
to redisplay the Ribbon. You 
can also use the arrow at the 
far right end of the Ribbon to 
collapse the Ribbon. To reopen 
it, click any of the tabs and 
then click the pushpin
icon at the far right end of the 
Ribbon to pin the Ribbon
open again.

Figure 1-3

The Ribbon

Home tab (active)

Group Dialog box launcher

Figure 1-4

The Font list
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7.    Click the  drop-down arrow  again to close the list. 

8.  Double-click the  Home  tab. This action collapses the Ribbon, hiding the groups of 

commands but leaving the tabs’ names visible on the screen. 

9.    Double-click the  Home  tab again to redisplay the Ribbon. 

  PAUSE .  LEAVE  the presentation open to use in the next exercise. 

 If you aren’t sure what a command does, just point to it. When the mouse pointer rests on a tool, 
a ScreenTip   appears. A basic  ScreenTip  displays the tool’s name and shortcut key (if a shortcut 
exists for that tool). Some of the Ribbon’s tools have enhanced ScreenTips that also provide a brief 
description of the tool. 

 Using the Mini Toolbar 

 In this exercise, you practice using the  Mini toolbar , a small toolbar that appears when you point 
to text that has been selected (highlighted). The Mini toolbar displays tools for formatting text 
appearance and alignment. The Mini toolbar is faint and semi-transparent until you point to it; 
then it becomes bright and opaque, indicating that the toolbar is active. If you right-click selected 
text, PowerPoint displays both the Mini toolbar and a  shortcut menu , which displays additional 
commands. 

STEP BY STEP  Use the Mini Toolbar 

  USE  the presentation that is still on the screen from the preceding exercise. 

1.    On the slide, double-click at the insertion point’s location. Because you double-clicked, 

the insertion point is highlighted. The Mini toolbar appears (see Figure 1-5). 

Take Note

Figure 1-5

The Mini toolbar appears by 

the highlighted insertion point

Font Font Size

2.      Click the  Font drop-down arrow  in the Mini toolbar. The list of available fonts opens. 

3.      Click the  Font drop-down arrow  again to close the list. 

4.    Move the mouse pointer back to the highlighted insertion point, then right-click. A 

shortcut menu with commonly used commands appears along with the Mini toolbar. 

5.    Move the mouse pointer to a blank area of the slide (such as the upper-left corner), and 

then click twice. The fi rst click removes the Mini toolbar and shortcut menu from the 

screen; the second click restores the slide to its original state. 

  PAUSE .  LEAVE  the presentation open to use in the next exercise. 

 Using the Quick Access Toolbar 

 The  Quick Access Toolbar  displays commands that you use frequently. By default, the Save, 
Undo, and Redo commands appear on the toolbar. You can add any commands to the Quick 
Access Toolbar for easy access to the commands you use most frequently. You can also choose 

Another Way
 You can also press 

Esc to close an open 

 drop-down list. 
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where the Quick Access Toolbar appears via the Customize Quick Access Toolbar button’s menu. 
In this exercise, you learn to use and customize the Quick Access Toolbar. 

 The Save command quickly saves an existing presentation while you are working on it or when 
you are fi nished with it. If you have not yet given the presentation a fi le name, PowerPoint will 
prompt you for a name by launching the Save As dialog box. If you have previously saved the fi le, 
the dialog box does not reopen. 

 The Undo command lets you reverse (“undo”) the action of your last command. The Redo button 
lets you reverse an undo action. If either the Undo or Redo command is gray, then you cannot 
undo or redo. 

STEP BY STEP  Use the Quick Access Toolbar 

  USE  the presentation that is still open from the previous exercise. 

1.    Look for the Quick Access Toolbar in the upper-left corner of the PowerPoint window. 

The Quick Access Toolbar appears in Figure 1-6. Yours may look different if it has been 

customized. 

Figure 1-6

The Quick Access Toolbar

2.    Click the  Save  button on the Quick Access Toolbar. The Save As tab of Backstage view 

appears. 

3.    Press  Esc  to return to Normal view. 

4.    Click the  Customize Quick Access Toolbar  button. A menu appears (see Figure 1-7). 

This menu lets you choose the tools you want to appear on the Quick Access Toolbar. 

Another Way
 You can also click 

the left-pointing arrow button 
in the top left corner of 
Backstage view to return to 
Normal view. 

Figure 1-7

Customizing the Quick Access 
Toolbar
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5.    Click  Show Below the Ribbon . The toolbar moves down and appears directly beneath 

the Ribbon. 

6.    Click the  Customize Quick Access Toolbar  button again. Click  Show Above the Ribbon . 

The toolbar moves back to its original location. 

7.    On the Home tab, right-click the  Bold  button. A shortcut menu appears (see Figure 1-8).  

Figure 1-8

Adding a button to the Quick 

Access Toolbar

8.    Click  Add to Quick Access Toolbar . A copy of the Bold button appears on the toolbar. 

9.    On the Quick Access Toolbar, right-click the  Bold  button. A shortcut menu appears. 

10.    Click  Remove from Quick Access Toolbar . The copy of the Bold button is removed. 

  PAUSE .  LEAVE  the presentation open to use in the next exercise. 

 Using KeyTips 

 When you press the Alt key, small letters and numbers—called  KeyTips —appear on the Ribbon. 
To issue a command by using its KeyTip, press the Alt key, and then press the key or keys that 
correspond to the command you want to use. Every command on the Ribbon has a KeyTip. 

STEP BY STEP  Use KeyTips 

  USE  the presentation that is still open from the previous exercise. 

1.    Press  Alt . Letters and numbers appear on the Ribbon and the Quick Access Toolbar 

(see Figure 1-9). These characters show you which keyboard keys you can press to 

access the tabs or the items on the Quick Access Toolbar. 

Figure 1-9

KeyTips
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2.    Press  N  to activate the Insert tab. When the Insert tab opens, notice that a new set of 

letters appears. These characters show you which keys to use to insert different kinds 

of objects in the current slide. 

3.    Press  P  to open the Insert Picture dialog box. 

4.    Click  Cancel  to close the dialog box and remove KeyTips from the display. 

  PAUSE  .   LEAVE  the presentation open to use in the next exercise. 

 KeyTips are one type of a keyboard shortcut .  In addition to the KeyTips, there are also many  other 
key combinations you can press to issue common commands that open dialog boxes, select and 
manipulate text, save, print, and much more. For example, Ctrl 1 S saves the current presentation, 
and Ctrl 1 Z reverses the last action taken. The PowerPoint Help system, covered later in this 
 lesson, provides a complete list of keyboard shortcuts available. 

 Keyboard shortcuts let you issue commands without using the mouse. This is handy for experi-
enced users who prefer to keep their hands on the keyboard as much as possible. In fact, if you 
master keyboard shortcuts, you may fi nd that you use the mouse less often over time. 

 You must press Alt each time you want to see a tab’s KeyTips. If you issue one command by a 
keyboard shortcut, you have to press Alt again to redisplay the tab’s KeyTips before you can issue 
another one. 

 Using Backstage View 

 The  File tab  is not a regular tab; instead of displaying Ribbon commands, it displays a full-screen 
menu called Backstage view. Each command you select along the left side of the Backstage view, 
screen displays a different dialog box or page of options and commands in the right panel.   

 Commands on the menu in Backstage view include the following: 

•   Info:     Shows information about the active presentation and provides commands that control 
permissions, sharing, and version management.  

•   New:     Lists available templates from which you can create a new presentation.  

•   Open:     Opens an existing presentation stored on a disk, either on your computer’s disk or a 
 network drive.  

•   Save:     Saves the current presentation   in your choice of locations  .  

•   Save As:     Lets you   re-  save a   previously saved   presentation   with a different name, type, or location 
than before.     

•   Print:     Provides settings and options for printing a presentation in a variety of formats.  

•   Share:   Provides options for sending the presentation via email, inviting others to view it online, 
and publishing slides to a slide library.  

•   Export  :     Offers a variety of options for saving a presentation in different formats, and publishing 
it to video, CD, or other media.  

•   Close:     Closes the currently open presentation.  

•   Account:   Enables you to choose which account you are signed into Offi ce with, manage 
 connected services like Facebook and YouTube, and get activation information.  

•   Options:     Opens the PowerPoint Options dialog box, from which you can confi gure many 
 aspects of program operation.  

 In PowerPoint 2010 there was an Exit command on the File menu. There is not in PowerPoint 
2013, but you can exit the application by closing its window, which you can do by clicking the 
X button in the upper right corner or pressing Alt 1 F4. 

Take Note

Take Note

Another Way
If you accidentally 

press Alt, you can clear KeyTips 
from the screen by pressing Esc 
or pressing the Alt key again.
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STEP BY STEP  Use Backstage View 

  USE  the presentation you used in the previous exercise. 

1.    Click the  File   tab  on the Ribbon. Backstage view opens. 

2.    Click  Share . Four options appear: Invite People, Email, Present Online, and Publish 

Slides. 

3.      Click  Email . Buttons appear on the right pane for sending various email versions

(see Figure 1-10).  

Figure 1-10

The Share tab in

Backstage view

4.        Click  Export  on the left pane. A list of export-related activities appears. 

5.        Click  Create a Video . Options and commands for completing that activity appear at the 

right (see Figure 1-11). 
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Figure 1-11

The Create a Video options in 

Backstage view

Another Way
To open the File 

menu by using KeyTips, press 

Alt, and then press F.

Another Way
You can also press 

Esc to close Backstage view.

Another Way
You can also open 

the Help window by pressing F1.

6.    Click  Open    in the left pane. A list of activities related to opening fi les appears. Recent 

Presentations is selected in the center pane, and a list of recently opened fi les appears 

in the right pane. 

7.  Click  New . A list of templates appears. 

8.  Click the  Back  arrow button in the upper left corner to leave Backstage view. 

  PAUSE  .   LEAVE  the presentation open to use in the next exercise. 

 Working with PowerPoint’s Help System 

 PowerPoint’s Help system is rich in information, illustrations, and tips that can help you complete 
any task as you create a presentation. Some of PowerPoint’s help information is stored on your 
computer, and much more is available via the Internet. Finding the right information is easy: you 
can pick a topic from the Help system’s table of contents, browse a directory of help topics, or 
perform keyword searches by entering terms that best describe the task you want to complete. In 
this exercise, you learn to access and use PowerPoint’s Help system. 

STEP BY STEP  Use the Help System 

  USE  the presentation that is open from the previous exercise. 

1.    Click the  Microsoft Offi ce PowerPoint Help  button    in the upper right corner of the 

PowerPoint window. The PowerPoint Help window appears (see Figure 1-12).  
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2.      Click the  Search  box, type  Ribbon , and then click the  Search  button or press  Enter . A 

list of help topics appears (see Figure 1-13). 

Figure 1-12

The PowerPoint Help window.



PowerPoint Essentials 13

Figure 1-13

Searching for help articles 
about the Ribbon

3.        Click the  Home button  in the PowerPoint Help window.  The main Help topics 

reappear (see Figure 1-12). 

4.    Click  Learn   PowerPoint   basics . The corresponding article appears. Read the article if 

you wish. 

5.  Click the  Back  button.  The main PowerPoint Help window reappears. 

6.  Click the  Use Large Text  button.  The text in the PowerPoint Help window becomes 

larger.  

7.    Click the  Use Large Text  button again. The text becomes smaller again. 

8.    Click  See w  hat’s new . The help topic appears in the window (see Figure 1-14). This help 

topic contains a video clip, which you can click to watch if you like. If you do so, a new 

window opens; close that window when you are fi nished watching. 

9.  Click the  Close  button to close the Help window. 
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Figure 1-14

Article explaining the new 
features in PowerPoint 2013

  PAUSE .  LEAVE  the presentation open to use in the next exercise. 

 PowerPoint’s Help window gives you access to many different help topics. A help topic is an article 
about a specifi c PowerPoint feature. Help topics can assist you with virtually any task or problem 
you encounter while working with PowerPoint. 

 The Help window is set up like a browser window and features some of the same tools you will 
fi nd in your Web browser, plus some additional buttons unique to the Help system. From left to 
right, the buttons across the top of the PowerPoint Help window are: 

•   Back:   Jumps to the previously opened Help topic.  

•   Forward:   Jumps to the next opened Help topic.  

•   Home:   Returns to the initial Help window.  

•   Print:   Prints the currently open Help topic.  

•   Use Large Text:   Toggles between normal-sized text and large text in the PowerPoint Help  window.  

 Many PowerPoint dialog boxes contain a Help button. When you click it, a Help window opens 
with information about the dialog box. 

 You can fi nd help in several ways. For example, you can type a word or phrase into the Search box 
and then click the Search button. A list of related help topics appears in the Help window. 

Take Note
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 Closing a Presentation 

 When you close a presentation, PowerPoint removes it from the screen. PowerPoint continues 
running so you can work with other fi les. You should always save and close any open presentations 
before you exit PowerPoint or shut down your computer. In this exercise, you will practice closing 
an open presentation. 

 STEP BY STEP Close a Presentation 

  USE  the presentation that is open from the previous exercise. 

1.    Click the  File  tab; Backstage view appears. 

2.    Click  Close . PowerPoint clears the presentation from the screen. 

  PAUSE .  LEAVE  PowerPoint open to use in the next exercise. 

   WORKING WITH AN EXISTING PRESENTATION 

 If you want to work with an existing presentation, you need to open it. After opening a presenta-
tion, you can use PowerPoint’s View commands to change the way the presentation is displayed 
onscreen; different views are suitable for different types of presentation editing and management 
tasks. You can also use PowerPoint’s Zoom tools to make slides look larger or smaller on the 
screen. The following exercises show you how to view your slides in different ways, and how to 
add, edit, and delete text on your slides. You will then learn how to print a presentation and to save 
it to a disk. 

 Opening an Existing Presentation 

 PowerPoint makes it easy to work on a presentation over time. If you can’t fi nish a slide show 
 today, you can reopen it later and resume working on it. The Open dialog box lets you open a 
presentation that has already been saved on a disk. Presentations can be stored on any disk on your 
PC or network or on removable media (such as a fl ash drive). You can also store presentations on 
your SkyDrive, which is a free online cloud storage location provided by Microsoft. You can use 
the Look In box to navigate to the fi le’s location, and then click the fi le to select it. This exercise 
shows you how to use the Open command to open an existing presentation—one that has already 
been created and saved as a fi le on a disk. 

STEP BY STEP  Open an Existing Presentation 

  GET READY . To open an existing presentation, do the following. 

1.  Click the  File    tab to open Backstage view. 

2.  Click  Open . The Open tab of Backstage view appears.  

3.      Click one of the following, depending on where the data fi les for this lesson are stored 

(see Figure 1-15): 

 * Click    [username’s]   SkyDrive    where  [username]    is the logged-in Offi ce user. 

 * Click  Computer  to access the drives on the local PC. 

4.  Click the  Browse button . The general location you selected in step 3 appears. 

The Bottom Line

Another Way
You can also open 

the Open tab of Backstage view 
by pressing Ctrl1O.
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5.  Browse to locate the data fi les for this lesson, and select    Blue Yonder Overview 

(see Figure 1-16). 

Figure 1-15

The Open tab of
Backstage view.

Another Way
Instead of clicking 

the fi le’s name in the Open 
dialog box and then clicking 
the Open button, you can 
double-click the fi le’s name to 
open the presentation.

Figure 1-16

Browse the data fi les for
this lesson.

6.  Click  Open . The presentation appears on your screen (see Figure 1-17). 
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Figure 1-17

The Blue Yonder Overview 

presentation

  PAUSE .  LEAVE  the presentation open to use in the next exercise. 

 When you click Open, you can choose whether to browse your SkyDrive or your Computer (local 
drives). SkyDrive is a cloud-based private storage system that Microsoft provides at no charge. 
Storing your fi les there makes them available to you no matter what computer you are using at 
the moment. However, accessing your SkyDrive requires Internet access, so if you do not always 
have Internet access available, storing fi les on your local hard drive may be a better option.  If you 
decide to store the data fi les for this book locally, you might want to put them in your Documents 
library for easy access. 

   Viewing a Presentation in Different Ways 

 PowerPoint’s various  views  enable you to see your presentation in a variety of ways. For example, 
in Normal view, you can work with just one slide at a time, which is helpful when you are adding 
text or graphics to a slide. Alternately, in Slide Sorter view, you can view all the slides in a presen-
tation at the same time, which makes it easy to rearrange the slides. The following exercise shows 
you how to change PowerPoint views. 

 PowerPoint provides these  views : 

•   Normal view     is the default view that lets you focus on an individual slide. The slide you are 
currently editing is called the   current slide  . The current slide appears in the Slide pane, which 
is the largest of   the   view’s three panes. Below the Slide pane is the Notes pane, where you can add 
and edit notes you want to associate with the current slide. The Notes pane is optional; you can 
toggle it on and off with the Notes button on the View   tab  . In the left pane—called the Slides 
pane—you can click the thumbnail images of the slides to jump from one slide to another, as you 
will see later in this lesson.        

•   Outline   view     is the same as Normal view except instead of thumbnail images of the slides, a text 
outline of the presentation appears in the left pane. Only text from placeholders appears in the 
outline; any text from manually created text boxes does not.  Text from graphical objects such as 
SmartArt also does not appear in the outline.  

Another Way
When you select 

File, Open, the Recent 

Presentations list appears. To 

open a presentation that 

appears on that list, click the 

presentation’s name.
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View tab

Figure 1-18

Normal view, with the View 
tab selected

•   Slide Sorter view   displays all the slides in a presentation on a single screen. (If there are more 
slides than can fi t in one screen, you can use scroll bars to move slides in and out of view.) In Slide 
Show view, you can reorganize a slide show by dragging slides to different positions. You can also 
duplicate and delete slides in this view.  

•   Notes Page   view   shows one slide at a time, along with any notes that are associated with the 
slide. This view lets you create and edit notes. You may fi nd it easier to work with notes in this 
view than in Normal view. You can also print notes pages for your presentation; they are printed 
as they appear in Notes Page view.  

•   Slide Show   view   lets you preview your presentation on the screen, so you can see it the way your 
audience will see it.  

•   Reading view     is like Slide Show view except it   i  s in a window rather than fi lling the entire 
screen. Displaying the presentation in a window enables you to also work in other windows at the 
same time.  

 STEP BY STEP Change PowerPoint Views 

  USE  the presentation that you opened during the previous exercise. 

1.    Click the  View  tab (see Figure 1-18). Notice that the Normal button is highlighted on both 

the Ribbon and the Views toolbar in the bottom-right corner of the PowerPoint window. 

 How can you use views to 
navigate through a 

presentation? 

1.3.3

2.    Click the  Slide Sorter View  button to change to Slide Sorter view (see Figure 1-19). 

Another Way
Instead of using the 

Ribbon to change views, you 
can use the Views toolbar in 
the lower-right corner of the 
PowerPoint window. The 
Normal button there toggles 
between Normal and Outline 
views each time you click it.
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 If formatted slides are hard to read in Slide Sorter view, press Alt and click a slide to see its heading 
clearly. 

3.  Click  slide 2 , and then click the  Notes Page View  button. PowerPoint switches to Notes 

Page view (see Figure 1-20). 

Take Note

Figure 1-19

Slide Sorter view

Views toolbar

Figure 1-20

Notes Page view
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 There is no button for Notes Page view on the Views toolbar at the bottom of the PowerPoint 
window; you must access it via the Ribbon. 

 If you have stored the data fi les on your SkyDrive, you may see a message at step 3 warning you 
that edits made in this view will be lost when saved to the server. That is not a concern at this 
point, so click View to continue. 

4.  Click the  Slide Show  tab, and click  From Beginning . The fi rst slide of the presentation 

fi lls the screen (see Figure 1-21).  

Take Note

Take Note

Another Way
You can also switch 

to Slide Show view by pressing 

F5 or by clicking the Slide Show 

icon in the bottom right corner.

Figure 1-21

Slide Show view

 If you have a widescreen monitor (16:9 height/width ratio), black panels appear to the left and 
right of the slide because this particular presentation is set up for 4:3 monitors.  

5.    Press  Esc  to exit Slide Show view and return to Notes Page view. 

6.    Click the  View  tab, and click the  Reading View  button. The fi rst slide appears in a 

reading window. It looks just like Figure 1-21 except it does not fi ll the screen. 

7.    Close the reading window by pressing  Esc .  

8.    On the Views toolbar, click the  Normal  button. PowerPoint switches back to Normal 

view. 

  PAUSE  .   LEAVE  the presentation open to use in the next exercise. 

 You will work with PowerPoint’s printing options and practice previewing a presentation later in 
this lesson. 

 Using Zoom 

 PowerPoint’s  zoom  tools let you change the magnifi cation of slides on the screen. By zooming out, 
you can see an entire slide; by zooming in, you can inspect one area of the slide. Both views have 
advantages: higher magnifi cations make it easier to position objects on the slide, and lower 
 magnifi cations enable you to see how all the parts of a slide look as a whole. In this exercise, you 
practice using the zoom tools. 

Take Note

Cross 
Ref
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STEP BY STEP Use Zoom 

USE  the presentation that is open from the previous exercise. 

1.       Click the  slide  in the Slide pane to ensure that the Slide pane is active. As a reminder, 

the Slide pane is the large pane on the right side of Normal view, in which one slide 

appears at a time. 

2.     On the View tab, click the  Zoom  button. The Zoom dialog box appears (see Figure 1-22). 

Figure 1-22

The Zoom dialog box
Zoom button

You can also

click here to

display the

Zoom dialog box

3.     Click the  200%  option button, then click  OK . In the Slide pane, the slide is magnifi ed by 

200%. Notice that you can no longer see the entire slide. 

4.   Click the  Zoom Out  button at the left end of the Zoom control, at the lower-right of the 

screen (see Figure 1-23). Continue clicking the button until the zoom level drops to 

 100% . Notice that, even at 100% magnifi cation, the slide is too large for the Slide pane. 

Another Way
You can click the 

Zoom level indicator at the far 
right of the Zoom control 
(located on the right end of the 
status bar) to display the Zoom 
dialog box.

Another Way
You can drag the 

Zoom control’s slider bar to the 
right or left to change the zoom 
level. However, in Normal view, 
dragging the Zoom slider chang-
es the zoom only in the Slide 
pane. If you want to change the 
zoom for a different pane, you 
must use the dialog box.
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 You can resize the Slide pane by dragging its bottom border up or down, or by dragging its left-
hand border to the right or left. The Slides pane (or Outline pane) and Notes pane also change size 
when you drag the borders. 

5.   Click the  Fit slide to current window  button at the far right end of the Zoom control. 

PowerPoint zooms out to fi t the entire slide in the Slide pane. 

  PAUSE .  LEAVE  the presentation open to use in the next exercise. 

 You can use either the Zoom dialog box or the Zoom control to change magnifi cation levels. In 
the Zoom dialog box, you can zoom in or out by choosing one of seven preset magnifi cation levels, 
or you can use the Percent spin control to set the zoom level precisely. All zoom options are avail-
able in Normal view. In Slide Sorter view, some zoom options are available, but the Fit slide to 
current window tool is not. 

 Viewing in Color or Grayscale 

  Grayscale  is a viewing mode in which there are no colors, only shades of gray. When you distrib-
ute a presentation using some low-tech methods, such as printing slides on a black-and-white 
printer, your slides might look different than they do in full-color on your screen. Therefore, it is 
sometimes useful to look at your slides in Grayscale mode on the screen so you can identify any 
potential problems that might occur when slides are printed without color.  There is also a Black 
and White viewing mode that can check how slides will look with only black and white (no gray 
shades). Some fax machines transmit only in black and white, for example, if you faxed your slides, 
you might need to know how the recipient will see them. 

Take Note

How can you view the 

presentation in grayscale 

mode?

1.3.2

Slide pane

zoomed to 100%

Fit slide to

current window

Zoom slider

Figure 1-23

Using the Zoom controls
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STEP BY STEP Switch Between Color and Grayscale Modes 

USE  the presentation that is open from the previous exercise. 

  1.   On the View tab, click  Grayscale . The presentation slides appear in grayscale mode, 

and a Grayscale tab appears on the Ribbon (see Figure 1-24). 

Figure 1-24

The Grayscale tab

  2.   Click several of the buttons on the Grayscale tab and observe the difference in the slide 

appearance. 

  3.   Click  Back To Color View . The presentation returns to color mode. 

  4.   On the View tab, click  Black and White . The presentation appears in Black and White 

mode, and a Black and White tab appears on the Ribbon. 

  5.   Click  Back to Color View . The presentation returns to color mode. 

  PAUSE .  LEAVE  the presentation open to use in the next exercise. 

   Viewing Multiple Presentations at Once 

 You can have multiple presentations open at the same time in PowerPoint, and you can arrange 
their windows so that they are all visible at once. This makes it easy to drag-and-drop content 
between windows, and also to compare different versions of a presentation. In the following exer-
cise you will open two presentations and arrange them.  

 STEP BY STEP Arrange Multiple Presentation Windows 

  USE  the presentation that is open from the previous exercise. You will also be opening a 

second presentation in this exercise so that multiple presentation windows are available to 

arrange. 

1.  Click the  File   tab . 

2.  Click  Open . The Open tab of Backstage view appears. 

3.  Navigate to the location containing the data fi les for this lesson. 

4.  Locate and open  Job Fair   1 . The presentation appears on your screen. 

5.  Click the  View  tab. 

6.  Click  Arrange All  in the Window group. The presentations appear side-by-side (see 

Figure 1-25). 

How can you view multiple 

presentations?

5.1.3
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7.  Use the Close button on the Job Fair 1 window  to close the Job Fair 1 

presentation, as you learned in “Closing a Presentation” earlier in this lesson. 

8.  In the Blue Yonder Overview window, click the  Maximize   button   in the upper-right 

corner. The PowerPoint window fi lls the screen. 

  PAUSE .  LEAVE  the presentation open for the next exercise. If you don’t wish to work with 

the maximized PowerPoint window, you can restore the window and then manually resize 

it to the size you prefer.  

 Moving Between Slides 

 PowerPoint provides a number of methods for moving through a presentation in different views. 
You can move from one slide to another with either the mouse or the keyboard. You can specify 
that a certain slide should be displayed, or you can browse the available slides to identify the one 
you want based on its content.  

 Using the Mouse to Scroll Through a Presentation 

 PowerPoint’s scroll bars let you move up and down through your presentation. When you drag the 
scroll box in the Slide pane, PowerPoint displays a ScreenTip with the slide number and slide title 
to show which slide will appear on screen when you release the mouse button. Click the scroll 
buttons to move up or down one line or one slide at a time, depending on the current zoom level. 
Click and hold a scroll button to move more quickly or drag a scroll box to move even more 
 quickly. In this exercise, you use the mouse to scroll through a PowerPoint presentation. 

Figure 1-25

Two presentations open 

side-by-side
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STEP BY STEP Scroll Through a Presentation Using the Mouse 

USE the presentation that is open and maximized from the previous exercise. 

1.  Click the  scroll down  button on the right side of the Slide pane (see Figure 1-26). 

Because the zoom level is set at Fit Slide to Current Window, slide 2 appears

on the screen. 

Previous Slide

Fit slide to

current window

Scroll Down

Next Slide

Figure 1-26

Scroll tools

2.  Use the zoom control to change the zoom level to  100% , then click the  scroll down  

button twice. Because the slide is now larger than the Slide pane, the scroll button 

scrolls the slide down in small increments instead of jumping to the next slide. 

3.  Click the  Fit to Window  button in the Zoom command group on the View tab of the 

 Ribbon . The  Fit to Window  button does the same thing as the Fit Slide to Current 

Window button on the status bar. 

4.  At the bottom of the scroll bar, click the  Next Slide  button twice. Slide 3 appears, and 

then slide 4 appears. 

5.  In the Slides pane on the left, scroll down to locate slide 5, and click it. The selected 

slide appears in the Slide pane (see Figure 1-27). 
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Figure 1-27

Click a slide’s thumbnail image 

in the Slides pane to jump to 

that slide.

Click slide 5

to display it

Scroll box

 The current slide’s number always appears in the lower-left corner of the status bar. 

6.  Point to the  scroll box  that appears to the right of the Slides pane, and then drag the 

scroll box all the way down to the bottom of the scroll bar. The last slide (slide 8) 

appears on the Slides pane, but slide 5 remains visible in the Slide pane. 

7.  Click the  Previous Slide  button (at the bottom right of the Slide pane, see Figure 1-26). 

Slide 4 appears in the Slide pane; notice that the slide also appears highlighted on the 

Slides pane. 

8.  Click the  scroll box  that appears to the right of the Slide pane, and then drag the scroll 

box all the way up to the top of the scroll bar. You return to the beginning of the 

presentation. 

  PAUSE .  LEAVE  the presentation open for the next exercise. 

 In Normal view, both the Slide pane and the Slides pane have scroll bars, buttons, and boxes. If 
there is text in the Notes pane, scroll tools will appear there to let you move up and down through 
the text, if necessary. In Slide Sorter view and Notes Page view, scroll tools will appear on the right 
side of the window if they are needed. 

 In  Normal view , you can click the Previous Slide button to move up to the previous slide and click 
the Next Slide button to move to the following slide. 

 Using the Keyboard to Move Through a Presentation 

 Your keyboard’s cursor control keys let you jump from one slide to another, as long as no text or 
object is selected on a slide. If text is selected, the arrow keys move the insertion point within the 
text; however, the Page Up, Page Down, Home, and End keys will still let you move from slide to 
slide. In this exercise, you practice using the keyboard to navigate through presentations. 

Take Note



PowerPoint Essentials 27

STEP BY STEP Move Through a Presentation Using the Keyboard 

USE  the presentation that is open from the previous exercise. 

1.  With slide 1 visible in Normal view in the Slide pane, press  Page Down  on your 

keyboard. Slide 2 appears. 

2.  Press  Page Down  to jump to slide 3. 

3.  Press  Page Down  to jump to slide 4. 

4.  Press  Page Up  to go back to slide 3. 

5.  Press  Page Up  to move up to slide 2. 

6.  Press  Page Up  to view slide 1. 

7.  Press  End  to jump to slide 8, the last slide in the presentation. 

8.  Press  Home  to return to slide 1. 

  PAUSE .  LEAVE  the presentation open to use in the next exercise. 

Working with Text 

 Text is not typed directly onto a slide in PowerPoint, but instead is placed in text boxes. A  text box
is, as the name implies, a box that holds text that you type into it. Most of the available slide lay-
outs have one or more placeholders that become text boxes when you type text into them, and you 
can also add more text boxes manually to slides, as you will learn in Lesson 3. Text can be placed 
on a slide either by typing it directly into a text box or placeholder, or by typing in the Outline 
pane in Normal view. In the following exercises, you will practice adding text to a placeholder; 
adding text to the Outline pane in Outline view; selecting, replacing, and deleting text on a slide; 
and copying and moving text from one slide to another. 

Adding Text to a Placeholder 

 In this exercise, you practice entering text in a  placeholder , which is a box that can hold either text 
or a graphic object. The placeholders available depend on the slide layout. In the Blue Yonder 
presentation, slide 1 is an example of a Title Slide layout; it contains two placeholders—one for the 
title and one for the subtitle. Placeholders make it easy to add text—just click in the placeholder, 
and then type the text. 

STEP BY STEP Add Text to a Text Placeholder 

USE  the presentation that is open from the previous exercise. 

1.  Click the  Home  tab. On slide 1, click at the beginning of the slide’s title ( Blue Yonder 

Airlines ). The borders of the title’s placeholder appear (see Figure 1-28), and a blinking 

insertion point appears before the word  Blue . 

Figure 1-28

The title placeholder

2.  Click the slide’s  subtitle , which is the second line of text. The subtitle’s placeholder 

appears, as does the insertion point. 

3.  Go to  slide 4  by clicking the slide in the Slides pane, or by pressing  Page Down  until

it appears. 
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4.  Click after the word  Snorkeling  in the second column. The insertion point appears. 

5.  Press  Enter  to start a new line, and type  Scuba . 

6.  Press  Enter , and then type  Sightseeing . Your slide should look like the one shown in 

Figure 1-29. 

Figure 1-29

Slide 4 with added text

  PAUSE  .   LEAVE  the presentation open for the next exercise. 

 Adding Text in Outline View 

 Working in Outline view is like working in a word processor. PowerPoint displays the text from 
each slide on the Outline pane, without any backgrounds, placeholders, or anything else that 
might distract you from your writing. You can navigate a presentation in the Outline pane the 
same way you use the Slides pane—scroll to the desired slide’s outline, and then click it. Here, you 
practice adding text on the Outline tab. 

 STEP BY STEP Add Text in Outline View 

  USE  the presentation that is open from the previous exercise. 

1.  Go to slide 8. This slide is supposed to contain contact information, but the mailing 

address and telephone number are missing. 

2.  Click the  View tab  and click  Outline   View . Because slide 8 is the current slide, its text is 

highlighted on the tab. 

 Remember that you can adjust the Zoom level for the Outline pane, or any other pane, as needed 
if the content is not shown at a convenient size for working with it. Click in the Outline pane and 
then on the View tab, click Zoom to open the Zoom dialog box, and choose a lower percentage, 
such as 50% or 33%, to shrink the text to a readable size. 

3.  In the Outline pane, click after the word  Airlines  on slide 8 to place the insertion point 

there. 

4.  Press  Enter  to start a new line. 

5.  On the new line, type  12 Ferris St  reet , and then press  Enter . As you type the new text 

in the Outline pane, notice that it appears on the slide. 

6.  Type  Diehard, TN 34567 , and then press  Enter . 

Take Note
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7.  Type  (707) 555-AWAY . Your slide should look like the one shown in Figure 1-30. 

Figure 1-30

Text added to the Outline pane 

appears on the slide

8.  Switch to Normal view. 

  PAUSE .  LEAVE  the presentation open for the next exercise. 

   Selecting, Replacing, and Deleting Text 

 You can edit, replace, and delete text directly on a slide. First, you must select the text to let 
 PowerPoint know you want to edit it. You can select any amount of text by dragging the mouse 
pointer across it. When you move the mouse pointer over text, it changes to an  I-beam pointer , 
a vertically oriented pointer that resembles the letter I. This pointer makes it easy to select text 
precisely. In this exercise, you practice editing text in PowerPoint. 

 STEP BY STEP Select, Replace, and Delete Text 

  USE  the presentation that is open from the previous exercise. Switch back to Normal view 

before starting the exercise. 

1.  Go to slide 3, and in the fourth item of the bulleted list on the right, double-click the 

word  advisor  to select it (see Figure 1-31). 
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Figure 1-31

Selected text

The word advisor

is selected

2.  While the text is selected, type  concierge . The new text replaces the selected text. 

3.  Go to slide 7, and select the word  ground  by dragging the mouse pointer over it. (The 

mouse pointer changes from an arrow to an I-beam whenever it is in a text placeholder, 

as shown in Figure 1-32.) 

Figure 1-32

Selecting text and the I-beam 

pointer

Mouse pointer

changes

to an I-beam

4.  Press  Delete  to delete the word from the slide. 

  PAUSE .  LEAVE  the presentation open for the next exercise. 
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Another Way
You can issue the 

Copy command by pressing 

Ctrl1C or by right-clicking and 

choosing Copy.

 Whenever you select text in PowerPoint—whether it is a single character or all the text on a 
slide—it is highlighted with a colored background. Once the text is selected, you can type new 
text in its place or delete it. 

 Only text from text-based placeholders appears in the Outline pane; text from manually created 
text boxes (see Lesson 2) and from graphics and charts does not appear. 

 Copying and Moving Text from One Slide to Another 

 In this exercise, you practice copying and moving text from one slide to another, using the Copy, 
Cut, and Paste commands. You can use these commands on many kinds of objects in PowerPoint, 
including pictures, charts, and placeholders. Don’t be surprised if these commands become your 
most frequently used tools, because they can save you a great deal of typing. 

   STEP BY STEP Copy and Move Text from One Slide to Another 

  USE  the presentation that is open from the previous exercise. 

1.  Go to slide 2, and in the slide’s title placeholder, select  Blue Yonder   Airlines  by 

dragging the mouse pointer across the text. 

2.  On the Home tab, click the  Copy  button (see Figure 1-33). 

Take Note

Figure 1-33

Clipboard tools

Cut

Paste

Copy

3.  Go to slide 7. 

4.  Click between the two words of the title to place the insertion point before the word 

 Guarantee . 

5.  On the Home tab, click the  Paste  button. PowerPoint inserts the copied text at the 

insertion point’s position (see Figure 1-34). Press the  Spacebar  if necessary to insert a 

space before the word  Guarantee . 
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 The Paste Options icon that appears near the pasted text in Figure 1-33 opens a menu when 
clicked; from that menu you can choose pasting options. In this case you will ignore the icon, 
accepting the default pasting options. 

Take Note

Figure 1-34

The selected text has been 

copied to slide 7

Another Way
You can issue the 

Paste command by pressing 

Ctrl1V or by right-clicking and 

choosing Paste.

Another Way
You can issue the 

Cut command by pressing 

Ctrl1X or by right-clicking and 

choosing Cut.

6.  Go to slide 3. 

7.  Select the last item of the bulleted list on the right side of the slide. 

8.  On the Home tab, click the  Cut  button. The selected item is removed from the list. 

9.  Go to slide 2. 

10.  Click below the last item of the bulleted list. 

11.  On the Home tab, click the  Paste  button. The item appears at the bottom of the list. 

12.  Click anywhere in the blank area around the slide to deselect the placeholder. Your 

slide should look like the slide shown in Figure 1-35. 

Figure 1-35

Selected text has been moved 

to slide 2

  PAUSE  .   LEAVE  the presentation open for the next exercise. 
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Another Way
You can press 

Ctrl1P instead of steps 1
and 2.

 Printing a Presentation 

 The PowerPoint Print command sends the currently open presentation to the printer. The default 
settings produce a printout of the entire presentation, one slide per page, on whatever printer is set 
up in Windows as the default.  

 STEP BY STEP Print a Presentation with the Default Settings 

  USE  the presentation that is open from the previous exercise. 

1.  Click the  File  tab .  

2.  Click  Print  .    Print options appear. You will learn about them in Lesson 2; leave the 

defaults set for now. Check with your instructor before completing the next step; to 

save paper, he or she may ask you not to print. 

3.  Click the  Print  button. PowerPoint prints the entire presentation, using the default print 

settings, assuming your PC has at least one printer set up.  

 Printing options are discussed in Lesson 2. 

  PAUSE .  LEAVE  the document open to use in the next exercise. 

 Saving an Edited Presentation 

 Whenever you work on a presentation, you should save it to a disk—especially if you have made 
changes that you want to keep. In this exercise, you will practice saving a presentation with a dif-
ferent fi le name, in native PowerPoint 2013 format.  

 In Lesson 10, you will learn how to save a presentation in other formats for sharing with people 
who might not have PowerPoint 2013 installed. 

 STEP BY STEP Save an Edited Presentation 

  USE  the presentation that is open from the previous exercise. 

1.  Click the  File  tab to open Backstage view. 

2.  Click  Save As . The Save As tab of Backstage view appears (see Figure 1-36). It is like 

the Open tab in that it allows you to choose between your SkyDrive and Computer as a 

starting point for browsing.  

Cross 
Ref

Cross 
Ref
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Figure 1-36

Save As tab of Backstage view

3.  Select the location where you want to save your fi les (ask your instructor for guidance), 

and then type  Blue Yonder Introduction  in the File name box (see Figure 1-37). 

Figure 1-37

Save As dialog box

 Ask your instructor if you should append your initials to the end of each fi le name for the  exercises 
in this book, to keep your fi les separate from those of other students. 

4.  Click  Save . 

5.  Click  File  and click  Close  to close the presentation. 

  PAUSE .  LEAVE  PowerPoint open to use in the next exercise. 

Take Note
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 Presentations created in PowerPoint 2007 and higher are incompatible with earlier versions of 
PowerPoint. However, you can save in an earlier format for backward compatibility; that skill is 
covered in Lesson 2. 

  When you need to save an existing presentation in a new location or with a different fi le name, use 
the Save As command. In the Save As dialog box, you can specify a different disk drive and folder 
to store the fi le; you can also give the fi le a different name in the File name box. After the presen-
tation is saved in the new location and with its new fi le name, you can click the Save button on the 
Quick Access Toolbar when you need to resave the fi le  .  

 You can also download a free conversion utility from the Microsoft website for earlier versions of 
PowerPoint that will allow those users to open fi les in PowerPoint 2007/2013 format. 

 Exiting PowerPoint 

 When you exit PowerPoint, the program closes and is removed from your computer’s memory. In 
this exercise, you will practice exiting PowerPoint. 

STEP BY STEP  Exit PowerPoint 

  GET READY . In order to exit PowerPoint, do the following. 

1.  Click the Close button on the PowerPoint window. 

 SKILL SUMMARY 

 In This Lesson, You Learned
How To: Exam Objective

Objective 
Number

 Work in the PowerPoint Window 

     Work with an Existing Presentation  Demonstrate how to use views to 

navigate through presentations. 

   Change to view in color/grayscale. 

   View multiple presentations. 

   1.3.3  

     1.3.2 

   5.1.3 
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